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Resize	pdf	without	losing	quality

Simple	Image	Resizer	Resize	image	without	losing	quality!	Last	updated	-	February	24,	2020When	you	are	managing	an	eCommerce	store	or	a	WordPress	site,	quite	often	you	will	need	to	modify	images.	Similarly,	if	you	are	printing	images	for	banners	or	poster,	it	is	important	to	enlarge	them.	You	might	want	to	occasionally	resize	images,	and	quite
often	the	result	will	be	bad	quality.	In	this	article	we	will	try	and	understand	different	options	to	resize	images	without	losing	quality.	You	can	use	the	resized	images	for	your	WordPress	site	or	WooCommerce	store	effectively.	How	image	resizing	affects	the	quality	of	the	image?	Most	photo	editing	software	will	have	an	option	to	resize	images.
However,	you	might	have	noticed	when	you	enlarge	certain	small	images,	the	picture	becomes	blurry	or	pixelated.	There	are	a	few	reasons	for	this.	Commonly	images	are	created	in	Bitmap	format,	which	forms	images	by	combining	pixels.	When	you	zoom	into	an	image,	you	will	be	able	to	see	individual	pixels	as	squares.	When	you	enlarge	a	small
image,	the	pixels	become	more	visible,	and	as	a	result,	you	will	feel	the	quality	of	the	image	is	diminished	through	pixelation.	You	will	find	photo	editing	software	that	will	resize	images	in	a	smart	way.	This	is	through	fractal	interpolation,	which	is	a	technique	that	will	resize	images	by	compensating	for	each	pixel	by	matching	it	with	the	properties	of
the	nearest	pixel.	This	technique	helps	a	lot	in	resizing	images	without	losing	quality.	How	to	resize	images	without	losing	quality?	First,	let	us	take	a	quick	look	at	how	you	can	resize	images	quickly	using	some	of	the	popular	tools.	GIMP	GIMP	is	the	acronym	for	GNU	Image	Manipulation	Program,	which	is	an	open	source,	free	software	that	will	help
you	edit	images.	It	has	great	customization	options	and	offers	a	user	friendly	interface	for	all	users.	You	can	even	use	third	party	plugins	to	enhance	the	functionality	of	GIMP	according	to	your	needs.	GIMP	is	one	of	the	most	popular	photo	editing	software	that	will	help	you	resize	images	without	losing	quality.	As	for	a	website	or	WooCommerce	store
owner,	you	can	use	this	software	for	producing	icons,	product	images	or	other	graphical	design	elements.	And	for	developers,	it	offers	great	scope	for	customization	with	support	for	multiple	languages	such	as	C,	C++,	Python	Scheme,	etc.	This	is	the	reason	why	you	will	find	a	lot	of	plugins	and	third	party	tools	available	for	GIMP.	Moreover,	you	can
use	it	for	accurate	color	reproduction	when	you	are	using	other	software	such	as	Scribus,	InkScape	and	SwatchBooker.	You	can	download	GIMP	from	its	website,	and	can	install	it	on	your	computer	effortlessly.	Resizing	images	with	GIMP	Here	are	the	steps	you	need	to	take	to	resize	images	using	GIMP.	Open	the	image	you	want	to	resize	on	GIMP.
On	the	menu,	click	Images	>	Scale	Image.	On	the	modal	window,	specify	the	desired	Image	size,	and	click	Scale.	Adobe	Photoshop	Adobe	Photoshop	is	one	of	the	most	popular	imaging	and	graphic	design	software	in	the	world.	You	can	find	professionals	and	amateurs	vouching	for	its		quality	all	around	the	globe.	Whatever	be	your	graphic	design
requirement,	there	is	a	solution	offered	by	Adobe.	You	can	create	and	edit	photographs,	videos,	illustrations	and	artwork	using	this	ubiquitous	tool.	Photoshop	is	one	of	the	most	popular	tools	when	it	comes	to	editing	and	enhancing	images.	Photoshop	offers	intuitive	tools	and	user-friendly	templates	that	will	enable	even	beginners	to	handle	it
effortlessly.	You	can	create	product	images,	website	banners,	event	posters,	web	graphics,	logos,	icons	and	more	using	Photoshop.	It	is	very	easy	to	make	modifications	to	image	by	experimenting	with	colors	or	effects.	It	also	helps	you	repair,	retouch,	adjust	and	crop	images	as	per	your	requirement.	You	need	to	choose	a	suitable	pricing	plan	to
purchase	Photoshop	and	associated	editing	tools	according	to	your	need.	The	pricing	plan	starts	from	$19.99	per	month.	Resizing	images	with	Adobe	Photoshop	Let’s	see	how	to	resize	images	without	losing	quality	using	Adobe	Photoshop	as	well.	Here	are	the	steps:	Open	the	image	to	be	resized	on	Photoshop.	On	the	menu,	click	Image	>	Image	size.
Specify	the	required	image	dimensions	and	click	the	OK	button.	Save	the	image	in	the	format	you	want.	Things	to	note	while	enlarging	photos	There	are	a	few	things	that	are	good	to	know	if	you	are	resizing	images	on	your	WooCommerce	store.	Enlarge	gradually	by	adding	smaller	percentages	Rather	than	directly	specifying	a	higher	size,	experts
advise	to	gradually	increase	the	image	size	in	small	percentages.	You	will	be	able	to	enlarge	images	up	to	200%	without	affecting	the	quality	on	any	photo	editing	software.	Beyond	that	if	you	are	enlarging	images,	it	is	better	to	go	for	a	professional	image	modifying	tool.	Check	the	size	of	your	original	image	If	your	original	image	is	considerably	large,
it	will	be	easier	to	enlarge	it	compared	to	a	smaller	sized	image.	Basically,	the	megapixel	number	of	your	camera	makes	a	difference	in	the	case	of	image	enlargement.	Photos	taken	using	higher	resolution	camera	will	be	therefore	easier	to	enlarge	without	problems.	On	the	other	hand,	smaller	images	and	images	taken	using	low	resolution	cameras
will	be	prone	to	distortions	while	enlarging.	Use	an	image	sharpening	tool	as	well	One	strategy	commonly	used	by	professionals	during	image	enlarging	is	to	enlarge	the	image	close	to	the	point	of	distortion,	and	then	sharpen	the	image.	This	way,	you	will	be	able	to	achieve	a	little	more	quality	than	expected.	Other	popular	tools	you	can	use	to	resize
images	Here	is	a	look	at	some	of	the	other	popular	tools	to	enlarge	images.	ON1	Resize	2019.6	This	software	user	fractal	interpolation	technology	and	is	capable	to	enlarge	images	without	affecting	quality.	You	can	use	it	as	a	standalone	tool	or	as	a	plugin	with	Photoshop.	The	latest	version	of	this	tool	comes	with	a	range	of	features	that	ensures	user
experience	as	you	will	be	able	to	modify	images	without	losing	any	detail.	It	can	be	a	great	asset	if	you	have	a	business	that	requires	regular	printing	of	images.	This	is	one	of	the	most	preferred	options	to	enlarge	photos	without	losing	quality,	and	can	be	used	a	standalone	tool	or	a	plugin.	Here	are	some	of	the	standout	features	of	ON1	Resize.	Ability
to	enlarge	images	up	to	1000%	without	losing	clarity	or	detail.	Gallery	wrap	feature	to	create	canvas	prints	to	stretch	or	reflect	the	edges	without	losing	any	part	of	the	image.	Numerous	presets	to	choose	the	perfect	print	size	for	your	images.	Ability	to	divide	photos	into	mosaic	tiles	for	easier	printing.	Great	preview	option	to	understand	exactly	how
the	print	would	look.	Access	the	photos	from	anywhere	–	computer,	network	or	cloud-based	storage.	Compressed	Photoshop	files	to	save	storage	space.	You	can	purchase	ON1	Resize	2019.6	for	$79.99,	which	you	can	install	on	up	to	5	devices.	Fotophire	Maximizer	This	tool	will	help	you	enlarge	your	images	upto	1000%	without	affecting	the	quality	or
detail.	If	you	are	looking	for	a	tool	to	enlarge	photos	for	printing	banners,	posters,	etc.,	this	is	a	great	tool.	You	can	even	create	close-up	shots	by	zooming	in	to	a	portion	of	the	photo.	Moreover,	it	gets	you	get	better	clarity	out	of	grainy,	low	light	photographs.	With	features	like	color	correction,	multiple	zoom	settings,	improved	edges,	etc.,	this	tool
will	help	you	print	high	quality	images	always.	You	can	enlarge	your	photos	without	distortion	using	this	popular	photo	editing	software	for	Windows.	The	one-year	subscription	of	Fotophire	Maximizer	will	cost	you	$29.99.	PIXresizer	This	is	a	free	software	that	will	help	you	resize	images	easily	to	make	them	email	and	web	friendly.	The	file	size	will	be
reduced	and	you	will	be	able	to	easily	upload	them	as	a	result.	Moreover,	you	can	use	this	tool	to	convert	images	between	different	formats	easily.	It	also	helps	to	rotate	images,	resize	multiple	images	together	and	convert	to	grayscale.	It	is	a	great	tool	to	make	sure	the	images	you	use	on	your	website	or	eCommerce	store	are	appropriately	sized.	This
is	a	free	tool	you	can	use	to	resize	images	without	losing	quality	for	website	or	email.	Reshade	Reshade	is	another	free	tool	that	you	can	use	to	resize	images	without	losing	quality	for	your	website	or	store.	It	uses	advanced	photo	enlargement	algorithms	to	produce	high	resolution	images.	You	can	use	this	tool	to	enlarge	images	up	to	2000%	without
blur	or	jagged	edges.	Reshade	supports	popular	image	formats	like	JPG,	PNG,	etc.,	and	also	supports	color	modes	like	MYK	and	RGB.	It	helps	you	work	with	photos	easily	as	you	can	batch	process	multiple	images	at	one	time.	If	your	work	needs	you	to	handle	a	lot	of	defective	photos,	this	is	a	good	tool	that	will	help	you	correct	them	without	hassles.
Reshade	is	a	good	free	tool	that	lets	you	enlarge	photos	and	correct	defects.	A	Sharper	Scaling	Another	free	tool	that	you	can	try	out	to	upscale	images	is	‘A	Sharper	Scaling’.	You	can	download	this	tool	for	free	and	use	on	your	Windows	computer.	It	uses	Bicubic	interpolation	and	image	sharpening	to	achieve	the	desired	results.	You	can	scale	images
up	to	300%	using	this	tool	without	considerable	distortions.	Hope	you	got	an	idea	on	how	to	resize	images	without	losing	quality	and	an	overview	on	some	of	the	free	and	premium	tools	for	it.	Leave	us	a	comment	if	you	have	a	query.	Further	reading	In	this	tutorial,	I’m	going	to	address	some	things	that	a	lot	of	people	don’t	know.	How	to	resize	an
image	in	Photoshop	and	keep	the	best	quality.		Here	is	what	I’m	going	to	cover.Simple,	no	thrills,	how	to	resize	images	for	beginners	who	just	want	to	do	it.What	is	resolution?	for	those	who	don’t	quite	get	it.Then	I’m	going	to	dig	in	a	bit	deeper	about	Interpolation	for	people	who	want	to	get	the	best	quality	upscaling	or	downsizing	images.Then	I’ll
give	you	a	few	tips	and	tricks	on	resizing	images	in	Photoshop	to	help	get	the	best	results	quicklyI	am	using	Photoshop	CC,	however	the	basics	apply	to	every	version	of	Photoshop,	although	the	resize	dialog	box	and	options	are	a	bit	newer	in	CC.		Don’t	forget	to	check	out	the	video	for	a	full	walk	through	and	look	at	the	written	info	below	for	more
details	or	specific	topics.	Learn	what	a	Polarizing	filter	and	a	split	ND	filter	do	and	how	to	use	them	for	sharp,	crisp	and...	How	to	make	your	own	Photoshop	actions.	Generating	Actions	of	your	Own,	Photoshop	Tutorial.	I'm	going	to	walk	through	the...	How	to	create	rock	textures	in	Photoshop.	It's	surprising	how	you	can	create	stunning	photorealistic
rock	and	stone	texture	so...	In	order	to	resize	an	image	without	losing	quality,	you	need	a	program	that	compresses	its	pixels.	Adobe's	tools	and	other	software	change	resolution	and	enlarge	images	without	pixelation.	Crop,	shape,	and	make	an	image	smaller	without	losing	quality	with	our	plethora	of	choices.	Take	a	closer	look	at	our	picks	below	to
find	the	best	editing	program	to	resize	your	images	and	keep	the	resolution.	To	fix	various	PC	problems,	we	recommend	Restoro	PC	Repair	Tool:	This	software	will	repair	common	computer	errors,	protect	you	from	file	loss,	malware,	hardware	failure	and	optimize	your	PC	for	maximum	performance.	Fix	PC	issues	and	remove	viruses	now	in	3	easy
steps:	Download	Restoro	PC	Repair	Tool	that	comes	with	Patented	Technologies	(patent	available	here).	Click	Start	Scan	to	find	Windows	issues	that	could	be	causing	PC	problems.	Click	Repair	All	to	fix	issues	affecting	your	computer's	security	and	performance	Restoro	has	been	downloaded	by	0	readers	this	month.	Manipulating	images	is	quite	an
important	task	in	the	digital	era.	Do	you	want	to	alter	the	size,	change	the	resolution,	or	simply	edit	your	pictures	without	losing	quality	in	the	process?	It	can	be	done	with	an	enormous	variety	of	software,	but	we	decided	to	focus	on	the	top	3.	Thing	is,	you	don’t	really	want	to	resize	the	photo.	This	operation	will	only	change	the	size	while	keeping	the
same	number	of	pixels.	What	you	want	to	do	is	to	resample	it.	So	make	sure	to	check	the	video	and	tools	below.	How	do	I	resize	an	image	without	losing	quality?	Here’s	how	to	resize	an	image	in	Adobe	Spark:	Download	Adobe	Spark	free	on	your	desktop.	Look	for	the	image	resizer	tool	in	your	workspace.	More	precisely,	you	may	find	it	in	the	sidebar
under	Resize.	Click	on	your	image	to	get	to	the	image	editing	menu.	Up	next,	simply	drag	the	handle	to	adjust	the	size	as	per	your	convenience.	You	may	also	select	the	Move	Freely	option	to	explore	capabilities	such	as	crop,	shape	crop,	and	more	creative	resize	options.	After	uploading	your	content,	add	text	and	graphics	or	get	even	more	creative
and	make	a	photo	collage	of	multiple	images.	Your	design	gets	saved	so	that	you	return	and	make	additional	changes	at	any	time.	If	you	want	to	professionally	resize	images	without	losing	quality,	this	is	the	program	you	should	focus	on.	Resizing	is	often	a	frustrating	experience	that	requires	editing	and	design	expertise.	As	you’ll	see	below,	that’s	not
the	case	when	using	Adobe	Spark.	An	abundance	of	features	and	overall	simplicity	are	waiting	for	you,	so	let	us	help	you	when	it	comes	to	your	questions	about	the	resizing	process.	Adobe	Spark	is	more	than	the	best	way	to	enlarge	images.	You’re	actually	getting	a	complete	package	that	can	help	you	create	stunning	graphics	for	all	occasions.	Resize,
crop,	and	create	stunning	graphics	to	perfectly	fit	your	artistic	vision	with	Adobe	Spark!	Here’s	how	to	resize	an	image	in	Adobe	Photoshop:	Open	Photoshop	and	drag	and	drop	the	image	you	want	to	resize	on	the	working	surface.	Click	Image	in	the	main	menu	and	select	Image	size	from	the	contextual	menu.	Now,	you	select	Pixels	in	the	right	tab
and	select	the	size	that	pleases	you.	Check	the	Resample	box	and	select	Preserve	Details	(enlargement)	from	the	drop-down	menu.	Choose	the	noise	reduction	percentage	and	click	OK	to	finally	resize	the	image.	After	that,	click	File	>	Save	as,	and	save	your	image,	preferably,	in	the	PNG	format.	Adobe	Photoshop	is,	as	we’re	all	aware,	the	most	used
premium	image	editing	tool.	This	isn’t	a	free	tool,	and	it	takes	some	time	to	process	the	immense	capabilities	it	offers.	It’s	an	obvious	choice	for	all	professional	users,	but,	once	you	get	the	hold	of	it,	it’s	rather	simple	to	use	even	if	you’re	a	newbie.	At	least	for	minor	tweaks.	Of	course,	the	final	result	is	much	better	than	on	other	similar	programs.
Experience	the	most	powerful	image	editing	and	resizing	tools	to	create	artwork	that	never	fails	to	impress	inPixio	Photo	Studio	Pro	11	is	a	simple	to	use	photo	editing	software.	It	features	options	for	removing	or	cropping	details,	objects,	people	or	even	the	backgrounds	from	your	images.	You	can	do	this	by	using	the	Remove	tool	to	get	rid	of
anything	that	you	do	not	want	into	your	pictures,	in	order	to	make	them	perfect.	Moreover,	the	Cut	tool	will	help	you	to	take	objects,	persons,	backgrounds	from	one	picture	and	add	them	to	another	picture.	With	these	easy	tools,	you	can	create	beautiful	photomontages.	However,	if	you	find	it	difficult	to	use,	the	software	has	an	interactive	assistant
and	numerous	step-by-step	tutorials	that	will	guide	you	through	the	tool’s	options.	Easily	edit	and	correct	errors	from	your	photos,	then	share	them	on	social	platform	with	one	great	software	tool.	Here’s	how	to	resize	an	image	in	GIMP:	Open	GIMP	and	drag	your	image	in	the	main	working	window	Click	on	Image	in	the	main	menu	and	then	click	on
Scale	Image	Select	the	preferred	output	resolution.	In	this	example,	we	doubled	the	image	resolution	(from	700	x	700	to	1400	x	1400).	Under	the	Quality	>	Interpolation,	select	Sinc	(Lanczos3).	Click	on	Scale	to	resize	the	image.	Now,	click	on	File	>	Overwrite…:	image	name:	to	overwrite	the	image	while	keeping	the	import	format.	And	that’s	it.	If
you’re	keen	to	keep	the	original	image,	make	sure	to	back	it	up.	GIMP	is	one	of	the	best	free	tools	you	can	use	for	basically	everything	regarding	images.	It’s	like	the	more	modest	free	version	of	Adobe	Photoshop	with	myriad	features	and	tools	that	make	it	an	incredibly	viable	option	for	home	users.	Of	course,	besides	the	standard	editing	and
optimizing,	you	can	enlarge	images	with	GIMP.	And	even	without	them	losing	little	to	none	of	their	original	quality	in	the	process.	⇒	Download	GIMP	That’s	it.	We	hope	this	was	enough	to	get	you	started.	Every	noted	program	has	its	pros	and	cons,	but	the	important	thing	is	that	all	can	meet	your	needs	regarding	the	lossless	image	resizing,	or	rather
image	resampling.	Try	the	best	one	that	suits	your	needs	and	keep	in	mind	that	there	are	other	tools	to	create	the	best	photos.	If	you	have	any	alternative	programs	to	recommend	or	questions	regarding	the	ones	we	presented	above,	do	tell.	You	can	do	so	in	the	comments	section	below.	This	article	covers:Topics:	image	resizersoftware	for	windows	10
Frequently	Asked	Questions	Was	this	page	helpful?	Join	the	conversation
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